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NATURE OF THE PROBLEM AND METHOD OF SOLUTION

The Micromechanical Combined Stress Analysis (MICSTRAN) code is a user-friendly

micromechanics program that runs in the MS Windows Tu_ environment on a IBM .2 personal

computer (PC) or compatible with a 80286 or higher microprocessor. A math coprocessor and a

80386 or higher processor are highly recommended. MICSTRAN calculates overall

thermoelastic constants and fiber-matrix stresses for a unidirectional composite or for a single ply

within a composite laminate.

Within a composite ply, fibers are arranged randomly and may resemble a square array in

some regions, a diamond array in some regions and a hexagonal array in other regions.

Micromechanics analyses usually assume that, within a ply, the fibers are arranged in a regular

repeating array. The square, diamond, and hexagonal arrays are often used to calculate overall

elastic constants and internal stresses in a composite ply. It has been shown [1] that the overall

elastic constants (except the longitudinal shear modulus) calculated using the square and diamond

array models can be averaged to obtain values that are close to those calculated using the

hexagonal array model. Under combined loading, the square and diamond array models have

been shown [2] to produce higher stress concentrations than the hexagonal array model.

MICSTRAN uses the square and diamond array models to calculate the overall thermoelastic

constants and internal stresses.

The micromechanics analysis developed in Ref. [3] for the square and diamond array

models is implemented in MICSTRAN. This analysis is based on a classical elasticity approach.

Figure 1 shows the reference cylindrical and Cartesian coordinate systems used in MICSTRAN.

The origin for both systems is located at the center of the fiber and the Z-direction for both

systems is along the fiber axis. The X-axis is constructed by joining the centerlines of two

adjacent fibers and the angle 0 is measured from the X-axis. The analysis uses the repeating unit

IMS Windows is a trademark of Microsoft Corporation.

2IBM is a registered trademark of International Business Machines Corporation.
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Fig. I - Configurations for the square and diamond array analysis.

cell ABCD for the square array and EGH for the diamond array as indicated by the shaded areas

in Fig. 1.

The fibers are assumed to be circular in cross section, homogeneous, and orthotropic with

transverse isotropy in the X-Y plane. The matrix is homogeneous and isotropic. The fiber and

matrix are perfectly bonded. A state of generalized plane strain is assumed (ez = constant) for

all loading cases except the longitudinal shear loading case. The loading is input with reference

to the Cartesian X-Y-Z coordinates. Stresses can be output in either the cylindrical or the

Cartesian systems. All radial coordinates are normalized by the fiber radius (Rf) in the input and

output of data. Details of the analysis procedure and comparison of stress results with finite

element results are given in Refl [3], which is included with this user guide.



INSTALLATION INSTRUCTIONS

MICSTRAN can be installed on a IBM PC or compatible. It requires MS Windows 3.0

running in either standard or 386 enhanced mode. It also runs under MS Windows 3.1 running in

386 enhanced mode. The distribution diskette should have the following files in order to insure

proper installation of MICSTRAN:

INSTALL.BAT

MICSTRAN.FOR

MICSTRAN.EXE

MICSTRAN. ICO

MICSTRAN.IN

MICSTRAN. OUT

QWIN.HLP

README.WRI

README.TXT

The INSTALL.BAT file contains commands that will automatically copy all required files

from the distribution diskette to your hard drive. MICSTRAN.FOR and MICSTRAN.EXE are

the FORTRAN source code and executable files, respectively. MICSTRAN.ICO is an icon file

that creates a color icon in the Windows environment. MICSTRAN.IN and MICSTRAN.OUT

are sample input and output files, respectively. The QWIN.HLP file contains online help for the

drop-down menu items. The README files contain installation instructions and important

information about MICSTRAN that was updated after this User's Manual was printed. The

README.WRI file can be read and printed by using the Windows Write program. The

README.TXT file can be read using any text editor (e.g. Windows Notepad). P!¢_¢ read the

README.TXT (or .WRD file before proceeding. The installation is performed in two major

steps. Step I involves copying required files to your hard drive. Step 1I involves setting up

MICSTRAN as a program item in Windows.



Available Hard Disk Space

Before you start it is important to check the available space on the hard drive.

MICSTRAN files need 270 Kbytes of disk space. If you save MICSTRAN output to a file, you

will need more space.

Step-By-Step Installation of MICSTRAN

Step I Instructions for Copying all MICSTRAN files on to your Hard Drive

Note: The first 3 instructions are for copying files from the floppy disk to a directory called

MICSTRAN on the hard disk. If you are familiar with the Windows File Manager, or an

equivalent file manager, then you can bypass these instructions by creating a directory called

MICSTRAN and copying all the MICSTRAN files (.exe, .ico, .in, .out) and the file QWlN.HLP

into it. You may then proceed to Step II of the instructions (starting with Instruction No. 2) for

setting up MICSTRAN as a program item in Windows. If you prefer to use the installation

program, the required files will be automatically copied by following the next three instructions.

lo

*

o

Insert the distribution diskette into a floppy drive on your system. If you are

currently running Windows move to a DOS prompt by _ Windows.

Make the floppy drive your current directory by entering either A: or B:

depending on which floppy drive the distribution diskette is in.

Enter INSTALL C: where C: is the hard disk drive that you would like to

install MICSTRAN to (e.g., INSTALL C:). Be sure to include the colon ":"

following the disk drive letter in your command. The installation program will

automatically copy all MICSTRAN files to a directory named MICSTRAN

on the drive you specify.
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m........----...m .... _----....w_......... _.w...--_..w......... ..... N----w .......... wwww.u ........... w...w..w.----w.._

Step II Instructions to Setup M]CSTRAN as Program Item in Windows 3.0 or 3.1

_.. ................ ww....... ..... . ................... ...._... ....... .------........ ......... _..------...--...--... .........

You should create a program item for MICSTRAN under the Program Manager in Windows.

This part of the installation will guide you in setting up the MICSTRAN icon in the program

group of your choice.

1. After the INSTALL program has finished copying all files, change back to

your hard disk drive (usually by entering C: ) and then re-start Windows

(usually by entering WIN ).

2. Highlight the group (e.g., Accessories) that you would like to place MICSTRAN

in by clicking on it with the mouse. Select "New..." from Program Manager's

"File" menu, make sure the "Program Item" radio button is selected, and click

on "OK". Click in the Description box and enter MICSTRAN. Click in the

Command Line edit box and enter C:\MICSTRAN_MICSTRAN.EXE

where C" is the disk drive that you chose to install MICSTRAN on in Step I,

Instruction No. 3.

3. If you have Windows 3.1 go to Instruction No. 4. For Windows 3.0, click

on "Change Icon" to get to the next menu. Now click in the Filename edit box

and enter C:\MICSTRAN_MICSTRAN.ICO and then click on the "View

Next" button. The MICSTARN icon will be displayed in the Box. Proceed to

Instruction No. 5.

4. For Windows 3.1, click on "Change Icon". A message saying "There are no

icons available in the specified file .... " will be displayed. Click on the "OK"

button to get the next menu. Use the backspace key to remove the highlighted text

(C:\WINDOWS\PROGMAN.EXE) in the F'dename edit box and enter

C:\MICSTRAN_MICSTRAN.ICO in the Filename edlt box. Next click on the

"OK" button or press enter and the MICSTRAN Icon will be displayed in the Box.
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Click on "OK '° and you should be back in the earlier Box. Click on "OK" and

you should see the MICSTRAN icon _ appear in your program group. If you

cannot see the MICSTRAN icon it may be because all of the icons cannot be displayed

at once; try using the "Arrange Icons" command from Program Manager's "Window _

menu as well as the group's scroll bar controls.

You are now ready to run MICSTRAN. Just double-click on the MICSTRAN

Icon and the program will be launched.

Full Screen MICSTRAN Display; - In the default mode, MICSTRAN runs in a

window that could sometimes be as large as your Program Manager window or

sometimes be quite small. You may use the maximize (A) button on the right hand top

comer to increase the window size. If you wish to force MICSTRAN to occupy the

full screen every time it comes up (highly recommended) then use a text editor such as

Windows Notepad to edit the WIN.INI file in your Windows directory and add the

following two lines to it:

[MICSTRANI

QWINMaximized = 1

Caution: It is a good idea to make a backup of the WIN.INI file before editing it. Do

not use the Windows Write program or your wordpr0eessor to edit the WIN.INI file

as it may corrupt the file and cause problems with the operation of Windows.

The installation of MICSTRAN is now complete and you are now ready to run the

MICSTRAN program. A sample input file called MICSTRAN.IN was copied to the

MICSTRAN directory during Step I of the installation. This file may be edited using a text

editor such as Windows Notepad to view the format of the input data. This file will be used to

demonstrate various aspects of the MICSTRAN program in the following section.
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USER INSTRUCTIONS

MICSTRAN can be launched simply by double-clicking on the MICSTRAN icon. It may

also be launched by choosing "Run" from Program Managers "Fde" menu, typing the full path

for the program (e.g. C:\MICSTRAN_MICSTRAN.EXE) and then hitting Enter or clicking on

the "OK" button. The program starts by displaying an introductory message (see Fig. 2). This

is an indication that MICSTRAN was properly installed on your computer.

_] MICSTRAN _

File Edit State Window Help

This program computes overall elastic
constants and fiber-matrix stresses under
combined thermomechanical loading using
square and diamond array unit cell models.

0
It needs fiber and matrix properties as Input
data.

It will output stresses under combined loading
and, upon request, also output stresses for
Individual loading cases.

To continue.,,
Press Enter or Click on the OK button.

Fig. 2 - Introductory MICSTRAN message at program startup.

If you get an error, make sure that Windows 3.0 is running in standard or 386 enhanced

mode. For Windows 3.1, make sure that it is running in 386 enhanced mode. If you still have

problems, check to see if all the MICSTRAN files (.exe, .ico, .in) are in the MICSTRAN

directory. If you still have problems, the files that you received on the distribution diskette may

be corrupt and you may need to get a new MICSTRAN diskette.



Input Data Format

After the message in Fig. 2, MICSTRAN asks whether input data is saved in a file. If the

response to this question is "Yes" then the user is asked to enter the input file name. Remember

that DOS allows only eight characters for the file name and three characters for the extension.

MICSTRAN can also be run with keyboard input. In this case the user will be prompted to enter

a descriptive title and the fiber and matrix properties.

Figure 3 shows the Input window for entering input data. The MICSTRAN.IN file is

used as a sample input file. It contains the following three lines:

MICROMECHANICS ANALYSIS OF AS413501-6 UNIDIRECTIONAL COMPOSITE

220.e9, 13.8e9, .20, .25, 34.e9, -.36E-6, 18.E-6, .625

4.3609e9, .34, 41.8135E-6

The first line is a descriptive title up to 80 characters long. The second line contains fiber

properties in the following order: Ez, Er, VZr, Vrr, Grz (Zz, oq., V r where, E is the

File Edit State Window Helpii_!( Output _

Enter Input File Hame: micstran.in

Enter Output File Name: micstran.out

_I_ .......l!_tl:l!_:a_l_:la::lp.. :.:<.::<.:++_:...<........,.....................................,.:_..................:.:<:,>.,.,.:,_>._:.,.+.,.,.,.+:::+::::<::::.<.......................:::>:::::+,:

Fig. 3 - The Input window for entering input data.



Young's modulus, v is Poisson's ratio, cz is the coefficient of thermal expansion and V r is the

fiber volume fraction (expressed as a fraction and not as a percentage). The subscripts Z and r

refer to the r-O-Z coordinate system. The third line contains isotropic matrix properties E, v,

and ct. Data is input in free format and can be separated by a comma or a space.

Units Used in Input and Output Data

It is necessary to use consistent units for all the properties used in the input data file.

Thus, if SI units are used for the moduli (Pa) then the coefficients of thermal expansion should

also be in SI units (m/m/°C) for both the fiber and matrix properties. MICSTRAN does not

check for consistency of the units. It will output elastic constants and stresses in the same units

that were used for the input data. Thus if the moduli were input in Pa then the output stresses

will also be in Pa. The above MICSTRAN.IN file uses SI units for all the data.

Output Window and Menu Bar

After reading the input either from a file or from the keyboard, MICSTRAN will ask if

you want to save output to a file and, if you say yes, it will ask you to enter an output filename

(see Fig. 3). Output will also appear in the Output window on the screen. This ouput may be

marked and copied using the Edit menu in the Top Menu Bar of the MICSTRAN window (see

Fig. 3). For help on using the menus in the Top Menu Bar, use the Help menu that appears in

the bar. When the screen gets full with output, scroll bars will appear on the side of the Output

window. These may be used to scroll through all the output that appears in the Output window.

Analysis Model

= The next two requests for input deal with the type of analysis that the user wishes to

perform. Either the square unit cell (Fig. 1), the diamond unit cell, or both may be requested for

calculating the overall composite properties and stresses. If both unit cells are chosen then the

square array analysis will be performed first.
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The nextrequestdealswith thecomputationof stressesunderappliedthermaland

mechanicalloads. If only overall elasticpropertiesarerequired,theresponseto this question

shouldbeNo. If your responseis Yesthenyouwill beaskedto entertheappliedloadsto the

model. If you haverequestedbothsquareanddiamondarrayanalysis,thesameloadswill be

usedfor bothanalyses.

Applied Stresses and Temperature Change

The applied stresses and temperature change (DELTA-T) are entered in the Input

Window which reappears on the screen (see Fig. 4). Once again the units used for the applied

• stresse_, and temperature change should be consistent with those used for the fiber and matrix

Eile Edit State _indow Help
...... J

_:_m_ 0 utp ut

HICRONECHNHICS NHALVSIS OF flS4/3501-6 UHIDIRECTIOHNL COHPOSITE

I::55::_:

EFZ
HuZR
GFRZ
ALFNZ
UF

Enter Input File Hame: micstran.in

Enter Output File Name: mtcstran.out

Enter DELTA-T: -150. B

Enter AppZted SIGHA-X: 92.5e6

Enter AppEied $]GHA-YZ: 2k.8e6 i

_:':_.:::_.:_:::::?;_::::::__._..'_:_ .',::::_-'.i:!_.'._::_:.',:!:!__:_ _ _::_:_::-:::::::-_: :::__::i::.'.:.'.::.'.:::.'.:::::::_i:.__:.-.::::___._.__..-"_(___::._._.__.__:_._;__':__ ._:._,__._',_ :'._',_'...,"_'_:4._i:_-:_-:.

_:':': _ : : ..... :::: =========================== '' " "_ " " ........ _ ....... " "l'f''"r"''"_''"''''"'Tl'I'r"l"''"-""r"lr"lTl'"l'lll'lll ............................................................................................

Fig. 4, Applied stresses and temperature change being entered in the Input window.

pro_rties in the input data. For example, the units for DELTA-T in Fig. 4 are oC to match the

units for cz in the input file MICSTRAN.IN. The X-Y-Z coordinate system (see Fig. 1) is used

10



to entertheappliedstressesto both themodels. If more than one applied stress is specified then

the internal stresses under the combined action of all applied stresses are output by default. Stress

output for each individual applied stress can also be requested.

Status Boxes and the Status Bar

MICSTRAN will display a Status Box as it proceeds with the calculations. Each Status

Box indicates the specific calculation that is in progress at a specific time. Sometimes there may

be a small pause between the time a Status Box disappears and the time when output is printed to

the Output Window. At such times the Status Bar at the bottom of the MICSTRAN Window

may be useful. Throughout the operation of the program the Status Bar indicates whether the

program is "Running" (see Fig. 2), whether "Input is Pending in the Input window" (see Figs.

3 and 4), or whether the program has "Finished".

Stress Output Location

As shown in Fig. 5, there are three choices for selecting the location where stress output is

desired. Using these three choices, the user is able to recover stresses at all possible locations in

both the square and diamond array models.

Stress output in the interior of the two models can be requested either along a circular arc

or at a set of user-selected points which extend from 0 - 90 degrees. In either case the stress

output location is specified in terms of thenormalized radial coordinate R,

R n = (r/Rf) (1)

where r is the desired radial coordinate and Rf is the fiber radius. For example, the fiber-

matrix interface is defined by a circular arc with R,, = 1. Locations in the fiber region will be

specified by Rn < 1 and locations in the matrix region will have R,_ > 1. The specified R,,

cannot be outside the model boundary. MICSTRAN automatically calculates the Rn values

11



File Edit State Window Help

Output

-_ Sbess Out _.t Location
OVERALL Y(

EXX = .9"
HuXY =

LOHGITUDIt

_VZ, GXZ =

TRAHSUERS[

_XY = .301

OUERALL C[

_LPHA-XX =
ALPHA-VV =
ALPHA-ZZ =

0

Stress output may be requested either along a
circular arc or at user-specified points extending
from 0- 90 degrees.
|i.e. in the first quadrant between the positive X-
and Y-axesJ

The following choices are available:
(1] Stresses at the fiber-matrix Interface
(2] Stresses along model boundary
(3] Stresses in the interior of the model.

Do you wish to output stresses at the fiber-matrix
interface ?

!ii_!

i:i}:
_ii!i

!iili
:fii!

!i:!ii_:

z_;z.

iiii i!

Fig. 5 - Choices for stress output locations.

for the boundary points for each model and displays them in the Input Window as Max. R,.

Specified Rn values cannot exceed the Max. R n value.

For the set of user-specified points, R n values are specified at 5 degree increments for

THETA varying from 0 - 45 degrees. The points are assumed to be reflected about the 45 degree

diagonal line for both models. MICSTRAN displays the Max. R, values for each angle in this

case (see Fig. 6). Additionally, the points specified cannot cross the fiber-matrix interface at any

point.

Output Coordinate System

The stress output locations are always specified in terms of THETA and R a. The stresses

at each location, however, may be output in either the cylindrical or Cartesian coordinate system

(see Fig. 1). The user selects this option following the specification of the stress output location.

12



File Edit State Window Help __| I

i_ Output }, _iii!iii

OUERALL YOUHGS HODUL] AND POISSOHS RATIOS, Z-FIBER DIRECTION

LOHGI_

The User-SpeciFied Points must be entered at 5 degree
increments For angles uarytng From 0 to 45 degrees.

Points are assumed to be reFlected about THETA - k5 deg.

P.YZ, G:Points CAHHOT cross the Fiber-matrix interface. _ _

TRAHSI EHTER normalized radial coordinate Rn (-r/RF), RF-Ftber radius

P,XY - ***Rn cannot exceed the Xax. Rn For a given angle !
= =

|Angle- 5.0D Hax. Rn- 1.12528 1.11
hLPHn-]Angle = 10.08 Hax. Rn = 1.13829 1.1g_
hLPHA- 1
hLPHA-LL - .lu7_L-uo

Fig. 6 - Specification of R,, values for stress output at user-specified points.

The next request for input asks whether stress output is desired at other locations. If the

response is Yes then the menu for selecting the location (see Fig. 5) is displayed once again.

Square and Diamond Array Analyses in Sequence

If both the square and the diamond array models are selected for the analysis, the square

array analysis is performed first. Thus, all the stresses at the requested locations are first

calculated for the square array. When these are completed, MICSTRAN alerts the user to this

fact and asks to proceed with the diamond array analysis. The stress output locations for the

diamond array analysis are requested by MICSTRAN at this point. The same applied loading that

was specified initially is used for the diamond array analysis.

13



Stress Output Format

When stresses for the inidividual loading cases are requested, only the non-zero stresses

are output. Thus, for the cases of applied DELTA-T, SIGMA-Z, SIGMA-X, SIGMA-Y or

SIGMA-XY, the longitudinal shear stresses are zero and are not included in the output.

Similarly, for the cases of applied SIGMA-YZ or SIGMA-XZ only the longitudinal shear stresses

are output since all the other stresses are zero. All six stress components are output for the

combined loading case. Since the Output Window can display a maximum of 80 columns, stress

output for the combined loading case is not fully visible on the screen. The right and left arrow

keys on the keyboard may be used to scroll the text horizontally. Alternatively, the Horizontal

Scroll Bar at the bottom of the Output Window can be used to scroll to the left or right

extremes of the output. If the Horizontal Scroll Bar is not fully visible, you may remove the

Status Bar at the bottom of the MICSTRAN Window by deselecting the Status Bar in the

Window menu in the Top Menu Bar.

Program Control

The MICSTRAN program runs in a fully multitasking mode. Thus, it can run in its

window (either maximized or minimized) while the user chooses to run other programs in other

windows. The File menu in the Top Menu Bar allows the user to terminate the program and

close its window at any time during its operation except when it is waiting for a response to a

question in a dialogue box. The State menu in the Top Menu Bar allows the user to temporarily

suspend program execution using the Pause command and resume execution with the Resume

command.

When the program terminates normally after completing the requested analysis it displays

a message that says "Program Terminated with exit code 0 - Exit Window ?" If you res_tmnd

by clicking Yes then the MICSTRAN window will be closed and all ouput in the Out0ut

window will be lost. If an output file was specified earlier, all output is written to and

automatically saved in that file, which can be read and edited with any text editor. The default

14



responseto this questionis No whichthenleaves the MICSTRAN window open and the output

in the Output window can then be manipulated as desired using the Edit menu in the Top Menu

Bar.

About Box

The About Box can be accessed from the Help menu in the Top Menu Bar. This box

contains information about the MICSTRAN version number and about the author of the

MICSTRAN program.

15



SAMPLE INPUT/OUT---PUT

The MICSTRAN.IN file (supplied on the distribution diskette) is used as a sample input

file in this manual. It contains the following three lines:

MICROMECHANICS ANALYSIS OF AS4/3501-6 UNIDIRECTIONAL COMPOSITE

220.e9, 13.8e9, .20, .25, 34.e9, -.36E-6, I$.E-6, .625

4.3609e9, .34, 41.8135E-6

The format and description of each of the entries in the above three lines was explained in the

Input Data Format section earlier. Besides the data contained in the input file, MICSTRAN

also relies on Interactive Data entered during program execution. The following data was

entered interactively for the present sample problem.:

Ouput file name: MICSTRAN.OUT

Analysis Model : Square and Diamond Array Models

Loading: DELTA-T = -150.0 (°C)

SIGMA-X = 92.5E6 (Pa)

SIGMA-YZ = 24.8E6 (Pa)

Stress Ouput: Each individual loading case and combined loading.

Square Array:

Stress Ouput Location: Along fiber-matrix interface (for Square Array).

Fiber or Matrix stresses: Matrix stresses at fiber-matrix interface.

Coordinate System for stresses: r-0-Z Cylindrical system (see Fig. 1).

Stresses at another location ? - No.

Diamond Array:

Stress Ouput Location: Along model boundary (for Diamond Array).

Coordinate System for stresses: X-Y-Z Cartesian system (see Fig. 1).

Stresses at another location ? - No.

16



The ouput is displayed in the Output Window on the screen and also stored in the

MICSTRAN.OUT file. A printout of the output is shown below:

MICROMECHANICS ANALYSIS OF AS4/3501-6 UNIDIRECTIONAL COMPOSITE

FIBER PROPERTIES

EFZ ffi .22000E+12 EFR ffi .13800E+11

NuZR - .20000E+00 NuRR - .25000E+00

GFRZ - .34000E+11
ALFAZ ffi -.36000E-06 ALFAR - .18000E-04

Vf ffi .62500

MATRIX PROPERTIES

EM =

ALFA ffi

.43609E+10 NuM ffi .34000

.41814E-04

RESULTS USING SQUARE ARRAY ANALYSIS

OVERALL YOUNGS MODULI AND POISSONS RATIOS, Z-FIBER DIRECTION

EXX - .93788E+10 EYY = .93788E+10 EZZ - .13916E+12

NuXY - .34201 NuZX ffi .24826 NuZY - .24826

LONGITUDINAL SHEAR MODULI

GYZ, GXZ ffi .63418E+10

TRANSVERSE SHEAR MODULUS

GXY 1, .30126E+10

OVERALL COEFFICIENTS OF THERMAL EXPANSION

ALPHA-XX ffi .31017E-04

ALPHA-YY = .31017E-04

ALPHA-ZZ ffi .18798E-06

MATRIX STRESSES ALONG F/M INTERFACE FOR DELTA-T ffi-.15000E+03

ANGLE Rn (=r/Rf) SIG-RR SIG-TT SIG-RT SIG-ZZ

.000 1.000 -.201819E+08 .203489E+08 .000000E+00 .272855E+08

17



5.000 1.000 -.188561E+08 .206481E+08 .439776E+07 .278380E+08

10.000 1.000 -.153423E+08 .214248E+08 .776592E+07 .292968E+08

15.000 1.000 -.107387E+08 .224085E+08 .951362E+07 .311965E+08
20.000 1.000 -.617422E+07 .233488E+08 .963496E+07 .330681E+08

25.000 1.000 -.237893E+07 .241075E+08 .852675E+07 .346164E+08
30.000 1.000 .385080E+06 .246502E+08 .669158E+07 .357407E+08

35.000 1.000 .216788E+07 .249983E+08 .452960E+07 .364652E+08

40.000 1.000 .313794E+07 .251883E+08 .227029E+07 .368596E+08

45.000 1.000 .344273E+07 .252483E+08 .150842E-05 .369836E+08
50.000 1.000 .313794E+07 .251883E+08 -.227029E+07 .368596E+08

55.000 1.000 .216788E+07 .249983E+08 -.452960E+07 .364652E+08

60.000 1.000 .385080E+06 .246502E+08 -.669158E+07 .357407E+08

65.000 1.000 -.237893E+07 .241075E+08 -.852675E+07 .346164E+08

70.000 1.000 -.617422E+07 .233488E+08 -.963496E+07 .330681E+08

75.000 1.000 -.107387E+08 .224085E+08 -.951362E+07 .311965E+08

80.000 1.000 -.153423E+08 .214248E+08 -.776592E+07 .292968E+08

85.000 1.000 -.188561E+08 .206481E+08 -.439776E+07 .278380E+08
90.000 L000 -.201819E+08 .203489E+08 -.382289E-07 .272855E+08

APPLIED AVERAGE STRESSES AND STRAINS FOR SIG-X ...92500E+08

AVG SX = .92500E+08
AVG SY = .22335E-05

AVG SZ = .58100E-06

STRAIN EX - .98627E-02

STRAINEYffi -.33731E-02
STRAIN EZ - -.16502E-03

MATRIX STRESSES ALONG F/M INTERFACE FOR SIG-X = .92500E+08

ANGLE Rn (= r/Rf) SIG-RR SIG-TT SIG-RT SIG-ZZ

.000 1.000

5.000 1.000

10.000 1.000
15.000 1.000

20.000 1.000

25.000 1.000

30.000 1.000

35.000 1.000

40.000 1.000
45.000 1.000

50.000 1.000

55.000 1.000

60.000 1.000

65.000 1.000
70.000 1.000

75.000 1.000

80.000 1.000

85.000 1.000

90.000 1.000

.124616E+09
122445E+09

116231E+09

106871E+09

956904E+08

840304E+08
728778E+08

627070E+08

535201E+08

449998E+08

.367009E+08

.282185E+08

.193425E+08

.101974E+08

.129382E+07

-.657211E+07

-.125881E+08
-.162503E+08

-.174586E+08

.590267E+08 .000000E+00 .617190E+08

.582757E+08 -.109772E+08 .607254E+08

.562083E+08 -.212190E+08 .579097E+08

.532843E+08 -.299388E+08 .537333E+08

.500248E+08 -.365362E+08 .488235E+08
468341E+08 -.408546E+08 .437743E+08

439350E+08 -.431808E+08 .389967E+08

413887E+08 -.440454E+08 .346729E+08

391430E+08 -.439874E+08 .307858E+08

370814E+08 -.433768E+08 .271880E+08
350633E+08 -.423385E+08 .236802E+08

.329556E+08 -.407557E+08 .200796E+08

.306621E+08 -.383208E+08 .162819E+08

.281571E+08 -.346619E+08 .123209E+08

.255174E+08 -.295386E+08 .839620E+07

.229409E+08 -.230292E+08 .484575E+07

.207314E+08 -.155787E+08 .204909E+07

.192281E+08 -.778317E+07 .292828E+06

,186944E+08 -.647044E-07 -.299457E+06

APPLIED AVERAGE LONGITUDINAL SHEAR STRESS AND STRAIN

AVG SIGMA-YZ " .24800E+08 STRAIN GAMMA-YZ I" .39105E-02
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MATRIX STRESSES ALONG F/M INTERFACE FOR SIGMA-YZ ffi .24800E+08

ANGLE Rn (=r/Rf) SIG-RZ SIG-TZ

.000 1.000 .00000000000E+00 .10228072508E+07

5.000 1.000 .28226362113E+06 .10323325440E+07

10.000 1.000 .71445346967E+06 .10600868422E+07

15.000 1.000 .14504681247E+07 .11027353640E+07

20.000 1.000 .26108699960E+07 .11535552145E+07
25.000 1.000 .42333695774E+07 .12038632261E+07

30.000 1.000 .62649081762E+07 .12460633357E+07

35.000 1.000 .86023853414E+07 .12759275776E+07

40.000 1.000 .11149899912E+08 .12928968742E+07
45.000 1.000 .13863012063E+08 .12987342464E+07

50.000 1.000 .16768249712E+08 .12953434869E+07

55.000 1.000 .19956489795E+08 .12824097217E+07
60.000 1.000 .23552836646E+08 .12553034949E+07

65.000 1.000 .27663563114E+08 .12034495013E+07

70.000 1.000 .32291399748E+08 .11096252290E+07

75.000 1.000 .37213092058E+08 .95182230209E+06
80.000 1.000 .41854492703E+08 .71062598867E+06

85.000 1.000 .45294443959E+08 .38368305519E+06

90.000 1.000 .46580897925E+08 .32866674575E-08

COMBINED LOADING APPLIED TO THE MODEL

DELTA-T _-.15000E+03

SIGMA-X ffi .92500E+08

SIGMA-YZ ffi .24800E+08

MATRIX STRESSES ALONG F/M INTERFACE UNDER COMBINED LOADING

ANGLE Rn (ffir/Rf) SIG-RR SIG-TT SIG-RT SIG-ZZ SIG-RZ SIG-TZ

.0 1.000 .10443E+09 .79376E+08 .00000E+00 .89004E+08

5.0 1.000 .10359E+09 .78924E+08 -.65794E+07 .88563E+08
10.0 1.000 .10089E+09 .77633E+08 -.13453E+08 .87206E+08

15.0 1.000 .96133E+08 .75693E+08 -.20425E+08 .84930E+08

20.0 1.000 .89516E+08 .73374E+08 -.26901E+08 .81892E+08
25.0 1.000 .81651E+08 .70942E+08 -.32328E+08 .78391E+08

30.0 1.000 .73263E+08 .68585E+08 -.36489E+08 .74737E+08

35.0 1.000 .64875E+08 .66387E+08 -.39516E+08 .71138E+08

40.0 1.000 .56658E+08 .64331E+08 -.41717E+08 .67645E+08

45.0 1.000 .48443E+08 .62330E+08 -.43377E+08 .64172E+08
50.0 1.000 .39839E+08 .60252E+08 -.44609E+08 .60540E+08

55.0 1.000 .30386E+08 .57954E+08 -.45285E+08 .56545E+08

60.0 1.000 .19728E+08 .55312E+08 -.45012E+08 .52023E+08

65.0 1.000 .78185E+07 .52265E+08 _ -.43189E+08 .46937E+08
70.0 1.000 -.48804E+07 .48866E+08 -.39174E+08 .41464E+08

75.0 1.000 -.17311E+08 .45349E+08 -.32543E+08 .36042E+08

80.0 1.000 -.27930E+08 .42156E+08 -.23345E+08 .31346E+08
85.0 1.000 -.35106E+08 .39876E+08 -.12181E+08 .28131E+08

.00000E+00

.28226E+06

.71445E+06

.14505E+07

.26109E+07

.42334E+07

.62649E+07

.86024E+07

.11150E+08

.13863E+08

.16768E+08

.19956E+08

.23553E+08

.27664E+08

.32291E+08

.37213E+08

.41854E+08

.45294E+08

.10228E+07

.10323E+07

.10601E+07

.11027E+07

.11536E+07

.12039E+07

.12461E+07

.12759E+07

.12929E+07

.12987E+07

.12953E+07

.12824E+07

.12553E+07

.12034E+07

.11096E+07

.95182E+06

.71063E+06

.38368E+06

19



90.0 1.000 -.37640E+08 .39043E+08 -.10293E-06 .26986E+08 .46581E+08 .32867E-08

RESULTS USING DIAMOND ARRAY ANALYSIS

OVERALL YOUNGS MODULI AND POISSONS RATIOS, Z-FIBER DIRECTION

EXX = .84712E+10 EYY = .84712E+10 EZZ w .13916E+12

NuXY w .40597 NuZX ffi .24814 NuZY - .24814

LONGITUDINAL SHEAR MODULI

GYZ, GXZ ffi .63418E+10

TRANSVERSE SHEAR MODULUS

GXY I .34943E+10

OVERALL COEFFICIENTS OF THERMAL EXPANSION

ALPHA-XX = .31002E-04

ALPHA-YY - .31002E-04
ALPHA-ZZ ffi .18873E-06

MATRIX STRESSES ALONG MODEL BOUNDARY FOR DELTA-T ffi -.15000E+03

ANGLE Rn (=r/Rf) SIG-XX SIG-YY SIG-XY SIG-ZZ

.000 1.585 .122132E+08 .122132E+08 .147715E-02 .355332E+08

5.000 1.463 .126557E+08 .126557E+08 -.676088E+06 .358341E+08

10.000 1.368 .124511E+08 .124511E+08 -.229611E+07 .356950E+08

15.000 1.294 .119110E+08 .119110E+08 -.504603E+07 .353277E+08
20.000 1.237 .107990E+08 .107990E+08 -.858134E+07 .345716E+08

25.000 1.193 .903463E+07 .903463E+07 -.125037E+08 .333718E+08

30.000 1.161 .670557E+07 .670557E+07 -.162785E+08 .317880E+08

35.000 1.138 .419912E+07 .419912E+07 -.193641E+08 .300836E+08

40.000 1.125 .219935E+07 .219935E+07 -.213436E+08 .287238E+08
45.000 1.121 .142733E+07 .142733E+07 -.220179E+08 .281988E+08

50.000 1.125 .219935E+07 .219935E+07 -.213436E+08 .287238E+08

55.000 1.138 .419912E+07 .419912E+07 -.193641E+08 .300836E+08

60.000 1.161 .670557E+07 .670557E+07 -.162785E+08 .317880E+08
65.000 1.193 .903463E+07 .903463E+07 -.125037E+08 .333718E+08

70.000 1.237 .107990E+08 .107990E+08 -.858134E+07 .345716E+08

75.000 1.294 .119110E+08 .119110E+08 -.504603E+07 .353277E+08

80.000 1.368 .124511E+08 .124511E+08 -.229611E+07 .356950E+08

85.000 1.463 .126557E+08 .126557E+08 -.676088E+06 .358341E+08

90.000 1.585 .122132E+08 .122132E+08 .147715E-02 .355332E+08

APPLIED AVERAGE STRESSES AND STRAINS FOR SIG-X ffi .92500E+08
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AVG SX - .92500E+08 STRAIN EX ffi .10916E-01
AVG SY I" .24930E+05 STRAIN EY ffi -.44317E-02

AVG SZ I- -.44455E+03 STRAIN EZ - -.16489E-03

MATRIX STRESSES ALONG MODEL BOUNDARY FOR SIG-X ,, .92500E+08

ANGLE Rn (=r/Rf) SIG-XX SIG-YY SIG-XY SIG-ZZ

.000 1.585 .944388E+08 -.831897E+07 .000000E+00
5.000 1.463 .911057E+08 -.813475E+07 .493064E+06

10.000 1.368 .878704E+08 -.440643E+07 .811417E+06

15.000 1.294 .845570E+08 -.768783E+06 .184165E+07

20.000 1.237 .831242E+08 .148630E+07 .311647E+07
25.000 1.193 .843883E+08 .150028E+07 .454171E+07

30.000 1.161 .879588E+08 -.376161E+06 .591056E+07

35.000 1.138 .923952E+08 -.299306E+07 .703072E+07

40.000 1.125 .959664E+08 -.511086E+07 .774832E+07

45.000 1.121 .973252E+08 -.590840E+07 .799336E+07
50.000 1.125 .959657E+08 -.511151E+07 .774897E+07

55.000 1.138 .923956E+08 -.299264E+07 .703030E+07

60.000 1.161 .879583E+08 -.376594E+06 .591100E+07
65.000 1.193 .843889E+08 .150090E+07 .454108E+07

70.000 1.237 .831230E+08 .148509E+07 .311768E+07

75.000 1.294 .845602E+08 -.765601E+06 .183846E+07

80.000 1.368 .878594E+08 -.441742E+07 .822411E+06

85.000 1.463 .911486E+08 -.809176E+07 .450076E+06

90.000 1.585 .944388E+08 -.831897E+07 -.504786E-07

.285617E+08

.274910E+08

.276587E+08

.277689E+08

.280485E+08

284830E+08
290590E+08

296777E+08

301718E+08

303626E+08
301714E+08

296779E+08

.290587E+08

284835E+08

280477E+08

277711E+08
276512E+08

275203E+08

285617E+08

APPLIED AVERAGE LONGITUDINAL SHEAR STRESS AND STRAIN

AVG SIGMA-YZ = .24800E+08 STRAIN GAMMA-YZ = .39105E-02

MATRIX STRESSES ALONG MODEL BOUNDARY FOR SIGMA-YZ ffi.24800E+08

ANGLE Rn (=r/Rf) SIG-XZ SIG-YZ

.000 1.585

5.000 1.463
10.000 1.368

15.000 1.294

20.000 1.237
25.000 1.193

30.000 1.161

35.000 1.138

40.000 1.125
45.000 1.121

50.000 1.125

55.000 1.138

60.000 1.161
65.000 1.193

70.000 1.237

75.000 1.294

80.000 1.368

.00000000000E+00
69510590009E+06

28373238642E+07

56312716181E+07
88679031200E+07

12299839941E+08

15671060337E+08

18639280940E+08
20741866860E+08

.21511665985E+08

.20741878393E+08

.18639250181E+08

.15671136075E+08

.12299632143E+08

.88685849767E+07

.56284994264E+07

.28513435838E+07

.11159769701E+08

.12460078116E+08

.12627020663E+08

.13153168219E+08
.14215915618E+08

.15867327499E+08

.17994084407E+08

.20232129660E+08

.21989660307E+08

.22663086525E+08

.21989648775E+08

.20232160419E+08

.17994008669E+08

.15867535297E+08

.14215233762E+08

.13155940411E+08

.12613000944E+08
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85.000 1.463 .61511744426E+06 .12540066572E+08

90.000 1.585 .89859564694E-08 .11159769701E+08

COMBINED LOADING APPLIED TO THE MODEL

DELTA-T - -.15000E+03

SIGMA-X ,I .92500E+08

SIGMA-YZ = .24800E+08

MATRIX STRESSES ALONG MODEL BOUNDARY UNDER COMBINED LOADING

ANGLE Rn (ffir/Rf) SIG-XX SIG-YY SIG-XY SIG-ZZ SIG-XZ SIG-YZ

.0 1.585 .10665E+09 .38942E+07 .14771E-02 .64095E+08 .00000E+00

5.0 1.463 .10376E+09 .45209E+07 -.18302E+06 .63325E+08 .69511E+06
10.0 1.368 .10032E+09 .80447E+07 -.14847E+07 .63354E+08 .28373E+07

15.0 1.294 .96468E+08 .11142E+08 -.32044E+07 .63097E+08 .56313E+07

20.0 1.237 .93923E+08 .12285E+08 -.54649E+07 .62620E+08 .88679E+07

25.0 1.193 .93423E+08 .10535E+08 -.79620E+07 .61855E+08 .12300E+08
30.0 1.161 .94664E+08 .63294E+07 -.10368E+08 .60847E+08 .15671E+08

35.0 1.138 .96594E+08 .12061E+07 -.12333E+08 .59761E+08 .18639E+08
40.0 1.125 .98166E+08 -.29115E+07 -.13595E+08 .58896E+08 .20742E+08

45.0 1.121 ,98752E+08 -.44811E+07 -,14025E+08 .58561E+08 .21512E+08

50.0 1.125 .98165E+08 -.29122E+07 -.13595E+08 .58895E+08 .20742E+08
55.0 1.138 .96595E+08 .12065E+07 -.12334E+08 .59762E+08 .18639E+08

60.0 1.161 .94664E+08 .63290E+07 -.10367E+08 .60847E+08 .15671E+08

65.0 1.193 .93424E+08 .10536E+08 -.79626E+07 .61855E+08 .12300E+08

70.0 1.237 .93922E+08 .12284E+08 -.54637E+07 .62619E+08 .88686E+07
75.0 1.294 .96471E+08 .11145E+08 -.32076E+07 .63099E+08 .56285E+07

80.0 1.368 .10031E+09 .80337E+07 -.14737E+07 .63346E+08 .28513E+07

85.0 1.463 .10380E+09 .45639E+07 -.22601E+06 .63354E+08 .61512E+06

90.0 1.585 .10665E+09 .38942E+07 .14771E-02 .64095E+08 .89860E-08

• 11160E+08
.12460E+08

.12627E+08

.13153E+08

.14216E+08

.15867E+08

.17994E+08

.20232E+08

.21990E+08

.22663E+08

.21990E+08

.20232E+08

.17994E+08

.15868E+08

.14215E+08

.13156E+08

.12613E+08

.12540E+08

• 11160E+08
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DESCRIPTION OF OPERATING ENVIRONMENT

The MICSTRAN program runs under the Microsoft (MS) Windows environment on a

IBM PC or compatible with a 80286 or higher microprocessor. It requires Windows 3.0 running

in standard or 386 enhanced mode or Windows 3.1 running in 386 enhanced mode. The

Windows standard mode requires at least 1 Megabyte of memory, and the 386 enhanced mode

requires a 80386 (or better) processor with at least 2 Megabytes of memory. MS Windows

provides a graphical user interface, facilitates multitasking, and extends memory access far

beyond the 640 Kilobyte limit imposed by the DOS operating system. A DOS version 3.1 or

later operating system is required to run MS Windows.

The source code MICSTRAN.FOR is written in Microsoft FORTRAN (version 5.1). It

contains calls to the Microsoft QuickWin libraries that are available with MS FORTRAN version

5.1. The MICSTRAN.EXE executable was created on an IBM PC with a 80486 processor and 4

Megabytes of memory using the following compilation command line:

FL /MW /G2 /Gt /Ot /OI /Fs MICSTRAN.FOR

The large memory model available with MS FORTRAN version 5.1 was used for the

compilation.
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